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Module 6

The Application of Earth Observation: Agricultural Water
Balance, Water Productivity & Water Stress Indices
with the Example of Assessments via PONTOS Platform
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Responsible Partner - Democritus University of Thrace
Supporting Partner - Centre for Research and Technology, Hellas

Slides and scripts prepared by - PhD loannis D. Tsakmakis, Dr Nikolaos T. Kokkos, Prof Georgios K. Sylaios
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LEARNING OBJECTIVES OF MODULE 6

Familiarize with satellite images characteristics
Introduction to vegetation indices - Normalized Difference Vegetation Index (NDVI)
Brief to NDVI calculation tools based on Sentinel 2 imagery

NDVI utilization as a crop model calibration/validation index
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Part 1: Introduction to satellite |
images characteristics and
vegetation indices

Part 2: NDVI calculation via

QGIS geographic information
system application

Part 3: NDVI as a crop model
calibration/validation index
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Introduction to satellite images characteristics

Spatial Resolution
The spatial resolution specifies a satellite’s image pixel size on the ground

Temporal Resolution
The amount of time needed by a satellite to revisit and acquire data for the exact

same location.

Spectral Bands
The number of spectral bands that the satellite mounted sensor(s) can capture
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Introduction to Vegetation Indices

0 Healthy plants absorb strongly red and Vegetation Reflectance
blue wavelengths during photosynthesis to
create chlorophyill.

0 A healthy plant reflects the largest portion
of the incident near infrared radiation.

0 Vegetation Index (VI) is a single value
derived by the transformation of two or
more spectral bands.

0 VIs are designed to allow the remote
assessment of plants photosynthetic
activity and canopy structural variations.
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Introduction to Normalized Difference Vegetation Index (NDVI)

o Normalized Difference Vegetation Index Near Visibie Ll Visible

(NDVI) is a single graphical indicator that
can be used to assess the plants health
status and the development of their canopy
cover.

Infrared Infrared

o Itis defined as the ratio between the
difference of the reflectance in near
infrared and red against the sum of the
reflectance in near infrared and red.

NIR — RED

NDV] = ——————
4 NIR + RED




£ o Black§ea
PONTOS Chovinarion @

Project funded by
EUROPEAN UNION 4

Common borders. Common solutions.




= ~ Black e

* * e

A ONTOS caoss sornta
st % -
Common borders. Common solutions.

Installing QGIS geographical information software

0 Open the following url in a browser: psaana
https://www.qggis.org/en/site/forusers/downl pownlond for Windows .

oad.html I
\/ OEGe etwork Instalier T

S o2 sllgloron e that i ionii
corresponds to your operating system (it is L TS
highly recommended to Choose the Iong ;:Z?;;jj;”“m"""""?'fmdlfaan;mp S0 Windows 7.1 Ionger works as we ane now Using Pyincn 3.9, which dropped
term release). sabvet

{ refsase or QGIS LYR [0 inalal (he Jong lerm reldase
s SOMNEE To v thage you tavis [0 use the Advanced

CAUTION: Upgradtes of okt 5e10ps from OSG084Y V1 using s tapasitory are not supparind. You peed o do 8 fresh netsll or 5= a

Standalone installers (M8)) fram OSGeodW packages (recommended for new usera)

Latast robase |riskeat on MatINa)

0 Once the download is completed install the *Q
QGIS in your system by double clicking on

Long term relesse (st stable):

the downloaded executable file. [ G ]
A f\ QGIS Standalons Instaler Version 3.22 a

sha256

Notn that the MS1 Insiallats sra mush bioger than the pravious netaliers. Thas i bacauss thay nelude significant larger nackages (oG
) Tha man reason for the swich 10 MS! wers the 5126 IImis proviousl usad NSIS has, which was biocking updstes of
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Getting started ...

o Open QGIS by: treseess B, e
> pressing the windows : ,_
key, typing qgis and
press the Enter )
button® ., ———79 |} =
> or double clicking on o

QGIS desktop e o
shortcut.

T |

o The QGIS user interface
Is initialized with zero
layers loaded by default.

T L L v o L ey e
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Installation of Semi-Automatic Classification Plugin (SCP)

0o From Plugins dropdown menu select Manage and Install Plugins...

(& Untitled Project — QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

N =B E'g_ {") & /& &% Manage and Install Plugins... | S=vy ' 0 v[Tl~
‘! @ vj ﬁ W M v & Python Console Ctril+Alt+p | 8 * = Q @ @ 2o
N Profile Tool — —
AeR S R do R LeR . - e\ OESEM[Y £3  [io,010000 R0

- = s |
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Installation of Semi-Automatic Classification Plugin (SCP)

o From the pop up window select
All and successively type Semi-
Automatic Classification Plugin
in the search bar and hit Enter
button.

0 Inthe results menu appears the
plugin latest release. By clicking
on it, the latest version number
and general info about the
plugin appear.

o Click on the Install Plugin button

seni-automiatie dassiication plugn

Black'yea

CROSS BONDER

GORRRA T an
Semi-Automatic Classification Plugin -

The Semi-Automatic Classification Plugin (SCP) allows for the supervised dassification of remote sensing images, providing
tools for th wenload, tf nd postor

Catogory Raster

Marg info
Anthar

Instatied version [
Availatsie version (stable)
Chamgelog 7

’
didnd unctice: procmss_sating b yet the munbe of then 0 v
povade Al Unminstall Pugin Refrstall Pugin

Close Hedp
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation

0 On a successful installation of the Gomtiil roc: a6

Project  Edit View Layer Sethnqs Plugms Vector Raster Database Web Mesh 5CP Processing Help

Semi-Automatic Classification Do BRER: G sL 0P 5% B O @ e o~
Plugin a new menu named SCP LA : 2 s 20 Q@8 200
will appear in the main menu bar. ~Gravar ool B -G BK D@mg pepocesng " 63 | BRo0io000 41D
- Browser & X and processing L
d 3l = ' ostprocessin L4
o Click on SCP and from the B isTee -
dropdown menu select Download O o it b ol ,
1] Home
products & oa o specrt i
* " [ DA lf-_" Scatter plot
,-;-,3' » [ EN zlz User manual
éa > [J6y o {8} Online help
Vi = 7 About
6?\;11' I\..ay:e:';* = & X Shaw plugin
|
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation
o From the Semi-Automatic Classification Plugin pop up window select the Login data tab and
successively, in the Login Sentinels category:

> fill in the Service box with the following url hitps://scihub.copernicus.eu/dhus/

» in User and Password boxes insert your Copernicus Open Access Hub username and password,

respectively.

E{? Semi-Automatic Classification Plugin ) . h
Filter L

=f Band set i Login data I D Search | . Download options é'
» {= Basic toals R s H

i izl 5/ ers. . usgs.

* Download products EE” andsat (b Ers.Or.u . . i

b [’ sri s = il | V| remembar £

» > Band processing Login ASTER and MODIS (https:

3 a Postprocessing

User Password | | W remember
ﬁ Band calc 2 =
° Batch Login Sentinels
» X Settings Service ;https.:..’,"scihub.co[:le!rnicus.eu..’nmue.uIr | :I

=|= User manual
{E: Help I User :itsnkmak Fassword !-o-.-.-.u | + | remember I

7 Ahant lza alarrstioa cnarch frr Cantinal 3 fna sithanticaticn ranicadl
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation
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o Switch to Download options tab. By default, the plugin has selected all the available satellite missions
and their corresponding bands.

o Deselect all the bands by clicking on the select all buttons located on the right side of the box

E“; Semi-Automatic Classification Plugin
|Filter |

g Band set ‘ Login data | D Search . Download options
» {= Basic tools

‘ Download products
» [4 Preprocessing
4 # Band processing

V| 1(Landsat 4-8) V| 2 (Landsat 4-8) V| 3 (Landsat 4-8) V| 4 (Landsat 1-8) V| 5 (Landsat 1-8) V| 6 (Landsat 1-8) E

» Postprocessing V| 7 (Landsat 1-8) V| & (Landsat 7, 8) V| 9 (Landsat 8) V| 10 (Landsat 8) V| 11 (Landsat 8) V| Andillary data
ﬁ Band calc Sentinel-2 bands
@ Batch

+ & Settings Vit V2 Vi3 V4 Vs Ve V7 Vs Visa Vs vl 10 v 11 v V| andlary data | (=
Z|= User manual Sentinel-3 bands
= Help
[ About Vi1 vl2 Vi3 vl 4 Vvls V6 V7 V)8 e vl 10 vl 11
" Support the SCP v 12 v 13 vl 14 V| 15 v 16 V|17 V| 18 V|13 V|2 V|21 V| Andilary data

Vi1 W2 W3 Wa Vs Vs =
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation

o Thenin the Sentinel-2-bands category select bands 4 and 8, which correspond to the wavelengths of
Red and Near Infrared respectively.

E}; Semi-Automatic Classification Plugin - O
Filter
ﬂ Band set ‘ Login data | D Search . Download options |
» = Basic tools
‘ Download products Landsat bands
» [+ Preprocessing 1 {Landsat 4-8) 2 (Landsat 4-8) 3 (Landsat 4-8) 4 (Landsat 1-8) 5 (Landsat 1-8) & (Landsat 1-8) E

4 # Band processing
» Postprocessing 7 (Landsat 1-8) 8 (Landsat 7, 8) 9 (Landsat 8) 10 (Landsat &) 11 (Landsat 8) Andillary data
ﬁ Band calc Sentinel-2 bands
@ Batch
» #% Settings
=|z User manual
o Help
[/ About

& Support the SCP 12 13 14 15 16 17 18 13 20 21 Ancilary data

GOES bands

Vi1 W2 W3 M4 M5 @6 =
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation

o Click on Search tab and define the co-ordinates of the study area by:

> (@) inserting the maximum and minimum longitude and latitude (bbox coordinates) in the
corresponding boxes using your keyboard

‘ Loain data .O Search | B covnload options |

UL |24 620863167 205 0. 9843095422967 LR |24 B2ISBEOO2E2D A0 B4TRUIRET 132 ® Show [:
YOGS SENMel 2 v AN oM | 2021051 ¢ | 10 | 20250511 Wiax floug cover (%) 1001
Results | 205 Advanced search Fnd J
[l Adid CpenSireet™ap to the map (@ OpenTrepthan The s lcensed & CC BY-SA, Tile Usage POy

Product ProductiD AcquisitionDate CloudCaver Zone/Path Row/DayNight min_lat min_lon max_lat max_len Collection/Size Preview Collection/ID  Collection/Imi
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation

» or (b) clicking the (+) button in the window upper right corner and then switching to the area map
(main QGIS interface) and click initially to define the first point that approximately corresponds to
the minimum longitude and maximum latitude of the study area and then click to define the second
point that corresponds to the maximum longitude and minimum latitude of the study area.

A rectangle with red fill should cover your study area, while the min/max longitude and latitude
boxes were filled in automatically.

.‘ Loain data .O Search | B covnload options |

UL |24.620863167 305 40.984395422067

LR |24 B215BE0036I9 H40.B4TROZRET132

®) She
Prochicts | Sentingl-2 v Date from | 2021-05-1 ~ | to | 20223-05-11 ~ Ma eloud cover (%) | 100 1
Rusiilts | 20 %] Advanced search Fnd J
Ll Add OpenSireetiap to the map (@ OpenrsetMan The cartography is licensed & CC BY-SA, Tile Usage PAicy)
:
Product ProductiD AcquisitionDate CloudCaver Zone/Path Rowi/DayNight min_lat min_lon max_lat max_len Collection/Size Preview Collection/Il  Collections/Imi
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation

o Once the study area is selected, check if the Sentinel 2 product is selected in the Products
dropdown menu and

» (a) define the time window that plugin will check for available products

> (b) define the acceptable products cloud cover (as percentage of the total image area).

‘ Loain data .O Search | B covnload options |

Search paramstars

Max cloud cover (%) 100 %1

e e 0. 9843095422967 A0 B4TRUIRET 132 = -
RsL | il |

Ll Add OpenSireetiap to the map (@ OpenrsetMan The is licensed & CC BY-SA, Tile Usage PAicy)
Product kst Filter
Product ProductiD AcquisitionDate CloudCaver Zone/Path Row/DayNight min_lat

min_lon max_ lat max_lon Collection/Size Preview Collection/ID  Collection/Imi
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation

o When the search is completed the available products for the selected area and time period will
appear in the Product list table.

l_?? Semi-Automatic Classification Plugin

= Band set
» b Basic tools
4 Download products
[‘ Preprocessing
 § Band processing
@ Postprocessing
I Band cale
@ Batch
» 3 settings
iE User manual
1 Hep
[7 About

A tgncits [0 serch | Ml Dowdoad cptives

UL 24.620663167205 |20 054305920057 IR 24 821586002620 |40 84780386712 | @) sow [¥]

Prodacts Sentinel-2 v Dite fraen (2002050 + | to 2023054 ~ Max dowd cover (%] 100
Results | 0% Aduemced search Fnd

an ‘Add Oen StrectMap to the mep (i CipenStretMap contribautors. The cartography is licensad as CC BY-5A. Tila Lsage Policy)

Product ProductiD AmuisitionDate  CloudCover Zoneffath Row/TiayMight min_lat miin_lan max lon Collection/Size Preview CollectionD  Collection/|
1 Senfinel-2 |24 TISTEF_AD26960_20220505T091048 5706, 180705 35THF 40,5085 134336 247538 1.03 G hitpssischubic.. 0b%d7bT-6283.. SEBMSILAY
2 Senfinel-2  L2A T34TGL A026360_20220505T091048 -05-05 34T 405049 233611 247106 10168 hitpsudsciub.c., 9e8bb34l-dead.. SZB MSILZY

% Sentinel-2  LIA TISTLF AQ26060_202205051061048 22-0 Z 35MF 40,5386 2456028 25,5346 1005.82 ME hitpsfischubic, 56041232671, 528 MSILHY
|4 Sentinel-2  L1C T35TLF ADZR960 20220505T091048 351LF 40,3386 246023 259346 72533 ME hittpstiscibubic., 19452023-9741.. 528 MSIL1Y

5 Sendinel-2  L1C_T35TKF_AG26560_20220505T091048 3 I5THF 405085 234336 2471536 745,63 MB httpsfisohub.c, Geldedf-d2fe. S2BMSILTY 6
| i Senfinel-2  L1C T34T0L AD26960 202205057091043 2022-05-05108... 13,7274 34TGL 40,5049 233611 247106 730,86 ME https:ischubic., 39017897-4¢t3-. 528 MSILTY =
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Using SCP to acquire Sentinel 2 imagery for NDVI calculation
o Select a product by clicking on it and press the RUN button.

o Alternatively, hold SHIFT key to select multiple products in row

o or hold CTRL key to select multiple products scattered within product list.

A L tn S Seart | Scwsived s

LT 5 13
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Calculating NDVI from Sentinel 2 products

o From the main toolbar click on the Layer dropdown menu and then select Add Layer — Add
Raster Layer

G “Untitled Project — QGIS
Project Edit View Layer Setlings Pligine Vadtor Raster Database Web Math SCP Procsising Help

| I 2 5 8 Datn Source Manager cui+l oS Fiwmv. - Tiw
WPV LM CeateLayer kL) = H AR ~fa B
- Add Layar ¥ VT Add Voctor Layer. - Ctrl 4 Shift v Y
v Ernbed Layers and Gioups.. B g Raster Layer CulsShif=R " mirsicen SEMe SO0 2
o Add frorm Layes Definifion Fie B Add Mesh Layer..
Vo g S Add Drlimited Tt tayer Ctrit Shift+T
s i . W, Add Postars Layers. Ctrbe shifts 0
E!‘ ' _,_:,m; A2 Add Spatislite Layer Cial+ Shifi+L
f i Home : BB Actcl MSSOUL Spatial Layer
pili 0 €A e 8, Add DB2 Spatiol Lyt Clabe Shift+2
ong At fi @ Add Oracle Spatial Layer... Cirl+ Shitt+0
® [+ b P e
o - B Add/Edit Virtual Layer -
@0 B Add WMS/WMTS Layer Culeshift R
T B2 Add XY Layer
& - @ Add AcGIS Map Service Layer.

on il & Add WCS Layar..,
1 Gaop Chl+D Vo Add WFS Layer..

W Add oIS Feah

Loyt B, A

Sarvice Layt

. CntoF |
Slatistios Lty & x

o0 Shaw All in Dvenveew
Statitic T5 Hidi Al frem Overview
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Calculating NDVI from Sentinel 2 products

o Inthe pop up window click on Raster Dataset(s), find the path that the downloaded raster (.tif) files
are saved, select them and successively press open, add and close.

Sowrve Type
alocd HTTR(S), toud, ol

Source
Raster detasetis) [SentieeQ'L2A_TIATCL M50 20720224T00114G 2022 02 24_con'AT, THTGL A0259%58 NDZU22ATOSL 146 OBHI* 1 ~

ATO9) 146 2332
= LI ]

A RT_TI4T04_A028

88 2002022410 BL0_J20c2810

a1146_H04 08 91186_308 W
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Calculating NDVI from Sentinel 2 products
o The images are loaded in the Layers panel and appear on the main map view

lllustration of
a Band 4
raster image

S 2 ‘
S S
‘.0‘ x e . v,

e |
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Calculating NDVI from Sentinel 2 products
o From the main toolbar click on the Raster dropdown menu and then select the Raster Calculator

(& *Untitled Project — QGIS
Project Edit View Llayer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

N (9 3’. Qppp Xl PF ¥ Raster Calculator... % | @ Y v
% @ v:j ﬁ LY - > Align Rasters... @] &= §
T ﬁ Georeferencer... i
hd b v - - - o LE@ v [l Analysis
VA Brcrsar Projections
'.U LT ®e Miscellaneous
@2 Favorites ?j;i‘:::ir;n
% > ¥ Spatial Bookmarks
= | > [& Hame
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Calculating NDVI from Sentinel 2 products

o Inthe pop up window define the path that the derived NDVI map file will be saved and the desired
format.

. L W= e
Q@ it

Raster Bands Result Layer

RT_T34TGL A023959 20220224T021145 B04@1
RI_T34TGL_AD25959 20220224T091146_BO8HT

2 Enter result file

€ -1 |mE——— v ] o

Opyavwon = Néos pameAog

GeollFF

A
Ovogex Hyepopnvia Toomom

# Tonyopn npoofiaon

B Emigavan spyooia # T Microsoft Teams

M Google Docs

$ Dogsiakigng  #
M Google Sheets

i
= ~ - "
Eyyeope » Google Shdes m
B Eiiveq o biblia_chora.gpka "
«- Google Drive (G)  # R Cisco Webex Meetings 271172 52
~ Operators
20 pépog #* epiebooks 22547 pp
i S b ] o) gis e+’ Chrome Remote Desktop 4/12/2020 546 uy
! a ams asin atan images & 2020 08 04 2 44 wu Office Lens wa A/8/2020 2.44
¢ v 2
< > - j= <= >= —
Ovopa apyclow. | wdvi
abs i Iriax
Anofifikevan we: Al Files (1)
Raster Calculator Expression

R
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Calculating NDVI from Sentinel 2 products

o Successively, insert the NDVI formula to the Raster Calculator Expression box using the band 4
and 8 raster images from Raster Bands panel and the available symbols from Operators panel and
r K n
press OK butto =

I 2000 146, 40
RTT A5

Psit Layor
959 2022052 4T091146 BUEE

Ot e L OSSR ARES D i ]
Otput fivmat G TIFF
Saoitad Liyer Exerd
min  [soe0n, 00000 * s [egrcn,00000
¥ [Ae00750 0w F er (8600000000
Cobueri |10 [ Fows [10080 3
Dwlput CRS EPSG 126 - WG5S 84 | UTM imne 344

= g u g ¢
! - ™ a L 1l
= 2= i o
145 TIATAL_hoZ
1145 TIATAL_ACZ

S1140_D0d@1" |
ATOS1146_30481°

Eaprmsiion vali
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Calculating NDVI from Sentinel 2 products

o If the Add results to project option is selected, the derived image is automatically loaded into the
Layers panel and displayed in the main map view.

Lyae ndwpons Lo burde Wups Dot Goimans Bt fonbboonn @Rk Mub 30 Dulpvecs Igios
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Crop initial NDVI map to field boundaries
o The NDVI map calculated in the e

Project Edit View layer Settings Plugine Vector Raster Database Wseb Mesh SCP  Proceszing  Help

preVious Step Corresponds to the [ H [ [E @ Data Source Manager Chrl+L ’ 1O =", v [Tl

G l’ B A Create Layer ¥ T g = = 1
boundaries of the downloaded CEEN e . fi::f";t"‘“* ;:Eavm?a
products. S e @ b =

': =y zo B CopySyk . Add DelimiitedTen Layer... Ct-j+$lv_irt—T '.
o Inthe case that the NDVI for a M| hs e s
h - . L = spatel @ Copy Layer > 4 L Spatia] Layer..,
selected field is needed, the previous 2 |2 B lewe § et s s
map is not that useful, so it has to be 8 e @ i
clipped to the field boundaries. ® L £ e
55?" ':!}‘j'!. - B B @ Add ArcGIS Map Servie Layer..
o In order to do that, from the main R it i O i
toolbar click on the Layer dropdown EE e W Asswcnthine
menu and then select Add Layer — s W |

Add Vector Layer... CORT

Skatishcs Labsling

©Z Show in Overview
! oo Show Allin Overview
Statistie F Hide All from Overview
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Crop initial NDVI map to field boundaries

In the pop up window click on Vector é
Dataset(s) and define the path where =~ TS
the field vector file is saved.

Incoding
Source
Vechie Tiatasat(s) |

G Open 06 Sugported Veclor Datassts!

Press successively the Open, Add and
Close buttons.
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Calculating NDVI from Sentinel 2 products

o The selected field polygon is loaded automatically into the Layers panel and displayed on the main
map view.
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Calculating NDVI from Sentinel 2 products
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o Subsequently, click on the Raster dropdown menu then select Extraction — Clip Raster by Mask

Layer...
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Calculating NDVI from Sentinel 2 products

o Inthe pop up window we initially set the NDVI map that we created in the previous steps as the
Input Layer and the field layer as a Mask layer.
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Calculating NDVI from Sentinel 2 products

In the Advanced Parameters section
set the path and the format of the
derived masked NDV!I file with field
boundaries and press Save button.

To initiate the mask process press
Run button.

Check the Open output file after
running algorithm.
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Calculating NDVI from Sentinel 2 products

o To derived masked NDVI map is i - O
loaded automatically into Layer panel
and displayed on the main map view.
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Plant canopy as crop model valldatlon lndex

One of the main parameters that is
used as an evaluation criterion of
crop model performance is the plants
canopy.

The traditional indices used as
means to assess plants canopy are
Leaf Area Index (LAI) or Green
Canopy Cover (CC).

Both require field measurements,
scientific instruments and post-
process of the measured data.
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NDVI as an alternative plant canopy index

o A number of studies have shown a fair
correlation between the NDVI and the CC
and LAI.

o Figures show correlation results between
measured CC and NDVI in the case of Corn
(Figure a) and Wheat (Figure b) and LAl
and NDV!I in the case of Wheat (Figure c)
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NDVI as an alternative plant canopy index

o These empirical equations can be used to
convert the NDVI map values derived from
satellite images to CC or LAI.

o Successively, the derived CC or LAI
timeseries can be used to validate crop
models performance.

o Figure shows an example of AquaCrop crop
model capability to simulate corn canopy
cover development using in-situ CC
measurements and NDVI derived CC.
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